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Manual abstract:
@@@@@@HP shall not be liable for technical or editorial errors or omissions contained herein. ENERGY STAR and the ENERGY STAR mark are
registered U. Safety information Always follow basic safety precautions when using this product to reduce risk of injury from fire or electric shock. 1. Read
and understand all instructions in the documentation that comes with the printer. Unplug this product from wall outlets before cleaning. 4. Do not install or
use this product near water, or when you are wet. Install the product in a protected location where no one can step on or trip over the line cord, and the line
cord cannot be damaged. 7.
If the product does not operate normally, see Solve a problem. 8. There are no user-serviceable parts inside. refer servicing to qualified service personnel.
Vision through the use of your operating system's accessibility options and features.
it also supports most assistive technology such as screen readers , Braille readers , and voice-to-text applications. For those who are color blind, colored
buttons and tabs used in the software and on the printer control panel have simple text or icon labels that convey the appropriate action. Mobility For those
with mobility impairments, the printer software functions can be executed through keyboard commands. the software also supports Windows accessibility
options such as StickyKeys , ToggleKeys , FilterKeys , and MouseKeys. The printer doors, buttons, paper trays, and paper guides can be operated by those
with limited strength and reach.
Support For more details about the accessibility of this product and HP's commitment to product accessibility, visit HP's web site at www. For accessibility
information for Mac OS X, visit the Apple web site at www. Accessibility The printer provides a number of features that make it accessible for people with
disabilities. Visual The printer software is accessible for those with visual impairments or low Contents 1 Get started Accessibility. 17 Tips for selecting and
using media. 51 Reprint received faxes from memory. 52 Set the paper size for received faxes. 54 Add numbers to the junk fax list. 54 Remove numbers from
the junk fax list. 55 Print a Junk List.
55 Receive faxes to your computer using HP Digital Fax (Fax to PC and Fax to Mac). 60 Set the number of rings before answering. 60 Change the answer
ring pattern for distinctive ring. 63 Set the fax sound volume. 67 Print the details of the last fax transaction. 72 Work with ink cartridges Information on ink
cartridges and the printhead. 80 After the phone support period. 85 Something on the page is missing or incorrect. 92 The printer prints half a page, then
ejects the paper. 94 Part of the document did not scan or text is missing.
113 Step 1: Make sure your computer is connected to your network. 114 Step 2: Make sure that the printer is connected to your network. 114 Step 3: Check to
see if the firewall software is blocking communication. 115 Step 4: Make sure the printer is online and ready. 116 Step 5: Make sure the wireless version of
the printer is set as the default printer driver (Windows only).
116 Step 6: Make sure your computer is not connected to your network over a Virtual Private Network (VPN). 117 After resolving the problems . 117
Configure your firewall software to work with the printer. 152 Notice to users of the Canadian telephone network. 153 Notice to users of the German
telephone network.
158 Disposal of waste equipment by users in private households in the European Union. 174 Select the correct fax setup for your home or office. 175 Case A:
Separate fax line (no voice calls received). 177 Case B: Set up the printer with DSL. 178 Case C: Set up the printer with a PBX phone system or an ISDN line.
179 Case D: Fax with a distinctive ring service on the same line. 182 Case G: Fax line shared with computer modem (no voice calls received). 183 Set up the
printer with a computer dial-up modem. 184 Set up the printer with a computer DSL/ADSL modem. 193 Case K: Shared voice/fax line with computer dial-up
modem and voice mail.
197 7 D Network setup (HP Officejet 4620 e-All-in-One series) Set up the printer for wireless communication. 198 Before you begin. 198 Set up the printer on
your wireless network. 199 Set up the printer using the HP printer software (Recommended). 199 Set up the printer using WiFi Protected Setup (WPS). 199
To connect the printer using the Push Button Method. 199 To connect the printer using the PIN Method. 200 Set up the printer using the embedded web server
(EWS). 216 8 1 Get started This guide provides details about how to use the printer and how to resolve problems.  • • • • • • • • • • • Accessibility Eco
Understand the printer parts Use the printer control panel HP Digital Solutions Select print media Load an original on the scanner glass Load an original in
the automatic document feeder (ADF) Load media Maintain the printer Update the printer Turn off the printer NOTE: If you are using the printer with a
computer running Windows XP Starter Edition, Windows Vista Starter Edition, or Windows 7 Starter Edition, some features might not be available.
For more information, see System requirements. Accessibility The printer provides a number of features that make it accessible for people with disabilities.
Visual The HP software provided with the printer is accessible for those with visual impairments or low vision by using your operating system's accessibility
options and features. the software also supports most assistive technology such as screen readers , Braille readers , and voice-to-text applications. For those
who are color blind, colored buttons and tabs used in the HP software and on the printer control panel have simple text or icon labels that convey the
appropriate action.
Mobility For those with mobility impairments, the HP software functions can be executed through keyboard commands. the HP software also supports
Windows accessibility options such as StickyKeys , ToggleKeys , FilterKeys , and MouseKeys. The printer doors, buttons, paper trays, and paper guides can
be operated by those with limited strength and reach. Support For more details about the accessibility of this printer and HP's commitment to product
accessibility, visit HP's web site at www. For accessibility information for Mac OS X, visit the Apple web site at www.
Get started 9 Chapter 1 Eco Hewlett-Packard is committed to providing quality products in an environmentally sound manner. Design for recycling has been
incorporated into this product. For more information, see Environmental product stewardship program. HP is committed to helping customers reduce their
environmental footprint. HP has provided these features to help you focus on ways to assess and reduce the impact of your printing choices. For more
information about HP's environmental initiatives, visit www. Manage Power To conserve electricity, the printer comes with the following features: Sleep
mode Power usage is reduced while in Sleep mode.
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After initial setup of printer, the printer will enter Sleep mode after 5 minutes of inactivity. to change the time to Sleep mode 1. From the Home screen on the
printer control panel, press the (Setup) button.
2. Using the buttons on the right, scroll to and select Preferences, select Sleep, and then select the desired option. Schedule On and Off Use the printer's
Schedule On and Off feature, and then select the days and time you want the printer to turn on and turn off automatically. For example, you can schedule the
printer to turn on at 8 a. In this way, you will save energy during the night and weekends. to configure the printer's Schedule On and Off feature 1. From the
Home screen on the printer control panel, press the (Setup) button. 2. Using the buttons on the right, scroll to and select Schedule On/Off, and then set the
time to turn on and off the printer. Conserve Printing Supplies To conserve printing supplies such as ink and paper, try the following: • • • Change the print
mode to a draft setting.
draft setting uses less ink. Do not clean the printhead unnecessarily. This wastes ink and shortens the life of the cartridges. Reduce paper usage by printing on
both sides of the paper. You can first print just the odd pages, flip the pages over, and then print just the even pages.
10 Get started Understand the printer parts This section contains the following topics: • • • Front view Printing supplies area Back view Front view 10 9 1 8 7
6 2 3 4 1 2 3 4 5 6 7 8 9 10 5 Automatic document feeder (ADF) Scanner glass Output tray Output tray extension Input tray Power button Control panel
display Control panel Document feeder tray Width guides Understand the printer parts 11 Chapter 1 Printing supplies area 3 2 1 1 2 3 Ink cartridge access
door Ink cartridges Printhead Back view 1 2 3 4 1 2 3 4 Fax port (2-EXT) Fax port (1-LINE ) Universal serial bus (USB) port Power input 12 Get started Use
the printer control panel This section contains the following topics: • • Overview of buttons and lights Change printer settings Overview of buttons and lights
The following diagrams and related tables provide a quick reference to the printer control panel features. 1 2 1 3 2 abc 5 jkl 3 def 6 mno 9 wxyz # 9 8 7 Label
1 2 3 4 Name and Description 4 ghi 7 pqrs 8 tuv 0 * ? @ _ 6 5 4 Home button: Returns to the home screen from any other screen. control panel display:
Shows the menu options. Keypad: Use the keypad to enter numbers and text. Help button: From the Home screen, pressing this button opens the Help menu.
When viewing screens other than the Home screen, pressing the Help button provides help applicable to the current screen. Setup button: From the Home
screen, pressing this button opens the Setup menu for generating reports and other maintenance settings. From the Copy, Fax, or Scan menus, pressing this
button opens available settings. hP ePrint button: Opens the HP ePrint menu. For more information, see HP ePrint. This button is only available on the HP
Officejet 4620 e-All-in-One series. Wireless button: Press this button to view or print the Wireless Summary or to access Setup options and the Network Menu.
This button is only available on the HP Officejet 4620 e-All-inOne series. cancel button: Stops a job , exits a menu , or exits settings. Back button: Returns to
the previous menu.
5 6 7 8 9 Use the printer control panel 13 Chapter 1 Change printer settings Use the control panel to change the printer mode and settings, print reports, or
get help for the printer. TIP: If the printer is connected to a computer, you can also change the printer settings using HP software tools available on your
computer. For more information about these tools, see Printer management tools. This section contains the following topics: • • • Select a mode Change the
mode settings Change the printer settings Select a mode The Home screen of the control panel display shows the available modes for the printer, such as
Copy, Fax, and Scan. To select a mode, press the button to the right of the mode that you want to use. Follow the prompts on the control panel display to
complete the job. The control panel display returns to the Home screen when the job is finished. (Home) button on the printer control panel to return to To
change modes, press the the Home screen, and then press the button to the right of the mode that you want to use. change the mode settings 1. After selecting
a mode, press the (Setup) button to scroll through the available settings, and then select the setting you want to change.
2. Follow the prompts on the display to change the settings. NOTE: Press the (Back) button to return to the previous menu. Change the printer settings To
change the printer settings or print reports, use the options available in the Setup menu: 1. From the Home screen, press the (Setup) button.
2. Using the buttons on the right side of the display, scroll through and select the desired settings or options. NOTE: Press the (Back) button to return to the
previous menu. HP Digital Solutions The printer includes a collection of digital solutions that can help you simplify and streamline your work. 14 Get started
This section contains the following topics: • • Scan to Computerinter.
HP Iron-on Transfers (for color fabrics or for light or white fabrics) are the ideal solution for creating custom T-shirts from your digital photos. HP Premium
Presentation Paper HP Professional Paper HP Bright White Inkjet Paper HP Printing Paper HP Office Paper HP Office Recycled Paper HP Premium Plus
Photo Paper HP Advanced Photo Paper HP Everyday Photo Paper HP Iron-On Transfers To order HP papers and other supplies, go to www. NOTE: At this
time, some portions of the HP web site are available in English only. 16 Get started Recommended papers for photo printing For the best print quality, HP
recommends using HP papers that are specifically designed for the type of project you are printing. Depending on your country/region, some of these papers
might not be available. HP Premium Plus Photo Paper HP’s best photo paper is heavyweight for producing professional quality photos. Features an instantdry finish for easy handling without smudging. This thick photo paper features an instant-dry finish for easy handling without smudging. it resists water ,
smears , fingerprints , and humidity. Your prints have a look and feel comparable to a store processed photo.
it is available in several sizes , including A4 , 8. 5 x 11 inch, 10 x 15 cm (4 x 6 inch), 13x18 cm (5 x7 inch), and two finishes – glossy or soft gloss (satin
matte). it is acid-free for longer lasting documents. Print colorful, everyday snapshots at a low cost, using paper designed for casual photo printing. This
affordable, photo paper dries quickly for easy handling. Get sharp, crisp images when you use this paper with any inkjet printer. HP Photo Value Packs
conveniently package original HP ink cartridges and HP Advanced Photo Paper to save you time and take the guesswork out of printing affordable, labquality photos with your HP printer.
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Original HP inks and HP Advanced Photo Paper have been designed to work together so your photos are long lasting and vivid, print after print. Great for
printing out an entire vacation’s worth of photos or multiple prints to share. HP Advanced Photo Paper HP Everyday Photo Paper HP Photo Value Packs To
order HP papers and other supplies, go to www.
NOTE: At this time, some portions of the HP web site are available in English only. Tips for selecting and using media For the best results, observe the
following guidelines.  • • Always use media that conforms to the printer specifications. For more information, see Media specifications. Load only one type
of media at a time into a tray or ADF.
When loading the trays and ADF, make sure the media is loaded correctly. For more information, see Load media or Load an original in the automatic
document feeder (ADF). Select print media 17 Chapter 1 • • Do not overload the tray or ADF. For more information, see Load media or Load an original in
the automatic document feeder (ADF). To prevent jams, poor print quality, and other printing problems, avoid loading the following media in the trays or
ADF: ◦ Multipart forms ◦ Media that is damaged, curled, or wrinkled ◦ Media with cutouts or perforations ◦ Media that is heavily textured, embossed, or
does not accept ink well ◦ Media that is too lightweight or stretches easily ◦ Media that contains staples or clips NOTE: To scan, copy, or fax documents that
contain pages that do not conform to these guidelines, use the scanner glass.
For more information, see Load an original on the scanner glass. Load an original on the scanner glass You can copy, scan, or fax originals by loading them
on the scanner glass. NOTE: Many of the special features do not work correctly if the glass and lid backing are not clean. For more information, see Maintain
the printer. NOTE: Remove all originals from the document feeder tray before lifting the lid on the printer. To load an original on the scanner glass Use these
steps to load an original on the scanner glass. TIP: For more help on loading an original, refer to the engraved guides along the edge of the glass. Load an
original in the automatic document feeder (ADF) You can copy, scan, or fax a document by placing it in the ADF. CAUTION: Do not load photos in the ADF;
this might damage your photos. Use only media that is supported by the printer.
For more information, see Tips for selecting and using media. NOTE: Only single-sided documents can be scanned, copied, or faxed using the ADF. The ADF
does not support double-sided documents. NOTE: Some features, such as the Fit to Page copy feature, do not work when you load your originals in the ADF.
You must load your originals on the glass. To load an original in the ADF Use these steps to load a document in the ADF. 1. Load your original print-side up
into the ADF. a. If you are loading an original printed in portrait orientation, place the pages so that the top edge of the document goes in first.
If you are loading an original printed in landscape orientation, place the pages so that the left edge of the document goes in first. b. Slide the media into the
ADF until you hear a tone or see a message on the display indicating that the loaded pages were detected. TIP: For more help on loading originals in the
ADF, refer to the diagram engraved in the document feeder tray. Load an original in the automatic document feeder (ADF) 19 Chapter 1 2.
Slide the width guides inward until they stop at the left and right edges of the media. Load media This section provides instructions for loading media into the
printer.  • • Load standard-size media Load envelopes Load cards and photo paper NOTE: Printing on custom-size media is not supported by this printer.
Load standard-size media To load standard-size media Use these instructions to load standard media. 1.
Pull out the input tray as far as possible. 2. Slide the paper width guide out as far as possible. 20 Get started 3. Insert the media print-side down in the tray.
Make sure the stack of media is inserted as far inside the printer as possible and does not exceed the line marking in the tray. NOTE: Do not load paper while
the printer is printing. 4. Slide the media guides in the tray until they touch the edge of the stack of media. 5.
Push in the input tray until it snaps into place. 6. Pull out the tray extender. Load media 21 Chapter 1 Load envelopes To load envelopes Use these
instructions to load an envelope. 1. Pull out the input tray as far as possible. 2. Slide out the paper width guides in the input tray as far as possible. 3. Insert
the envelopes print-side down and load according to the graphic.
Make sure the stack of envelopes does not exceed the line marking in the tray. NOTE: Do not load envelopes while the printer is printing. 4. Slide the media
guides in the tray until they touch the edge of the stack of envelopes. 5.
Push in the input tray until it snaps into place. 22 Get started 6. Pull out the tray extender. Load cards and photo paper To load cards and photo paper Use
these instructions to load photo paper. 1.
Pull out the input tray as far as possible. 2. Slide out the paper width guide in the input tray as far as possible. load media 23 Chapter 1 3. Insert the media
print-side down in the tray. Make sure the stack of media is inserted as far inside the printer as possible and does not exceed the line marking in the tray. If
the photo paper has a tab along one edge, make sure the tab is pointing towards the front of the printer. NOTE: Do not load paper while the printer is
printing. 4. Slide the media guides in the tray until they touch the edge of the stack of media.
5. Push in the input tray until it snaps into place. 6. Pull out the tray extender. 24 Get started Maintain the printer This section provides instructions for
keeping the printer in top working condition. perform these maintenance procedures as necessary.  • • Clean the scanner glass and lid backing Clean the
exterior Clean the ADF Clean the scanner glass and lid backing Dust or dirt on the scanner glass, scanner lid backing, or scanner frame can slow down
performance, degrade the quality of scans, and affect the accuracy of special features such as fitting copies to a certain page size. to clean the scanner glass
and lid backing 1. Turn off the printer. For more information, see Turn off the printer.
Clean the glass and lid backing by using a soft, lint-free cloth that has been sprayed with a mild glass cleaner. 1 2 1 2 Lid backing Scanner glass CAUTION:
Use only glass cleaner to clean the scanner glass. Avoid cleaners that contain abrasives, acetone, benzene, and carbon tetrachloride, all of which can damage
the scanner glass. Avoid isopropyl alcohol because it can leave streaks on the glass. CAUTION: Do not spray the glass cleaner directly on the glass.
If too much glass cleaner is applied, the cleaner could leak under the glass and damage the scanner. 4. Dry the glass and lid backing with a dry, soft, lint-free
cloth.
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5. Close the scanner lid, and turn on the printer.
clean the exterior WARNING! Before cleaning the printer, turn the printer off by pressing the (Power) button, and unplug the power cord from the electrical
socket. Use a soft, damp, lint-free cloth to wipe dust, smudges, and stains off of the case. Keep fluids away from the interior of the printer, as well as from the
printer control panel. 26 Get started Clean the ADF If the ADF picks up multiple pages or if it does not pick up plain paper, you can clean the ADF. to clean
the ADF 1. Turn off the printer. For more information, see Turn off the printer. Lightly dampen a clean lint-free cloth with distilled water, then squeeze any
excess liquid from the cloth. 5. Use the damp cloth to wipe any residue off the rollers or separator pad.
NOTE: If the residue does not come off using distilled water, try using isopropyl (rubbing) alcohol. Maintain the printer 27 Chapter 1 2 3 1 1 2 3 ADF cover
Rollers Separator pad 6. Close the cover of the ADF. Close the scanner lid, and turn on the printer. Update the printer HP is always working to improve the
performance of its printers and bring you the latest features. If the printer is connected to a network and Web Services has been enabled, you can check for
and install printer updates. To update the printer, complete the following steps: 1. On the printer control panel, press the (ePrint) button, press the (Setup)
button, and then press the button to the right of Printer Update. 2. Press the button to the right of Check for Update Now, and then follow the instructions on
the display.
To enable the printer to automatically check for updates: 1. On the printer control panel, press the (ePrint) button, and then press the (Setup) button. 2. Using
the buttons on the right, select Printer Update, select Auto Update: Off, and then select On. Turn off the printer Turn the printer off by pressing the (Power)
button located on the printer.
Wait until the power light turns off before unplugging the power cord or turning off a power strip. CAUTION: If you incorrectly turn the printer off, the print
carriage might not return to the correct position, causing problems with the ink cartridges, and print quality issues. Turn off the printer 29 2 Print Most print
settings are automatically handled by the software application. Change the settings manually only when you want to change print quality, print on specific
types of paper, or use special features. For more information about selecting the best print media for your documents, see Select print media.
Choose a print job to continue: Print documents Print brochures Print on envelopes Print photos Print borderless documents or photos NOTE: Printing on
custom-size media is not supported by this printer. Print documents Follow the instructions for your operating system.  • Print documents (Windows) Print
documents (Mac OS X) TIP: This printer includes HP ePrint, a free service from HP that allows you to print documents on your HP ePrint-enabled printer
anytime, from any location, without any additional software or printer drivers. For more information, see HP ePrint. print documents (Windows) 1. Load
paper in the tray. For more information, see Load media. 2. On the File menu in your software application, click Print. 3.
Make sure the printer you want to use is selected. 30 Print 4. To change settings, click the button that opens the Properties dialog box. Depending on your
software application, this button might be called Properties, Options, Printer Setup, Printer, or Preferences. 5. Change the paper orientation on the Layout
tab, and paper source, media type, paper size, and quality settings on the Paper/Quality tab. To print in black and white, click the Advanced button, and then
change the Print in Grayscale option. NOTE: If you want to print a black and white document using black ink only, click the Advanced button. From the Print
in Grayscale drop-down menu select Black Ink Only, then click the OK button. Load paper in the tray.
For more information, see Load media. From the File menu in your software application, click Page Setup. NOTE: If you do not see a Page Setup menu item,
go to step 3. b. Make sure the printer you want to use is selected in the Format For pop-up menu.
c. Select the paper size from the Paper Size pop-up menu, and then click OK. From the File menu in your software application, click Print. Make sure the
printer you want to use is selected. Select the paper size from the Paper Size pop-up menu (if available).
Change the print settings for the option provided in the pop-up menus, as appropriate for your project. NOTE: If you do not see any options, click the
disclosure triangle next to the Printer pop-up menu or click Show Details. Print brochures Follow the instructions for your operating system.  • Print
brochures (Windows) Print brochures (Mac OS X) TIP: This printer includes HP ePrint, a free service from HP that allows you to print documents on your
HP ePrint-enabled printer anytime, from any location, without any additional software or printer drivers. For more information, see HP ePrint. Print
brochures 31 Chapter 2 Print brochures (Windows) NOTE: To set print settings for all print jobs, make the changes in the HP software provided with the
printer. For more information on the HP software, see Printer management tools. Load paper in the tray. For more information, see Load media. On the File
menu in your software application, click Print.
Make sure the printer you want to use is selected. To change settings, click the button that opens the Properties dialog box. Depending on your software
application, this button might be called Properties, Options, Printer Setup, Printer, or Preferences. 5. Change the paper orientation on the Layout tab, and
paper source, media type, paper size, and quality settings on the Paper/Quality tab. To print in black and white, click the Advanced button, and then change
the Print in Grayscale option. Load paper in the tray. For more information, see Load media. From the File menu in your software application, click Page
Setup. NOTE: If you do not see a Page Setup menu item, go to step 3.
b. Make sure the printer you want to use is selected in the Format For pop-up menu. c. Select the paper size from the Paper Size pop-up menu, and then click
OK. From the File menu in your software application, click Print.
Make sure the printer you want to use is selected. Select the paper size from the Paper Size pop-up menu (if available). Click Paper Type/Quality from the popup menu, and then select the following settings: • Paper Type: The appropriate brochure paper type • Quality: Normal or Best NOTE: If you do not see these
options, click the disclosure triangle next to the Printer pop-up menu or click Show Details. 7. Select any other print settings that you want, and then click
Print to begin printing.
Print on envelopes Avoid envelopes with the following characteristics: • • Very slick finish Self-stick adhesives, clasps, or windows 32 Print • • Thick,
irregular, or curled edges Areas that are wrinkled, torn, or otherwise damaged Make sure the folds of envelopes you load in the printer are sharply creased.
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NOTE: For more information about printing on envelopes, see the documentation available with the software program you are using. Follow the instructions
for your operating system. Load envelopes print-side down in the tray. For more information, see Load media. On the File menu in your software application,
click Print. Make sure the printer you want to use is selected. To change settings, click the button that opens the Properties dialog box. Depending on your
software application, this button might be called Properties, Options, Printer Setup, Printer, or Preferences. 5.
On the Layout tab, change the orientation to Landscape. 6. Click Paper/Quality, and then select the appropriate envelope type from the Paper Size drop-down
list. TIP: You can change more options for the print job by using the features available on the other tabs in the dialog box. Load envelopes in the tray. For
more information, see Load media. From the File menu in your software application, click Page Setup. NOTE: If you do not see a Page Setup menu item, go
to step 3. b. Make sure the printer you want to use is selected in the Format For pop-up menu.
c. Select the appropriate envelope size from the Paper Size pop-up menu, and then click OK. From the File menu in your software application, click Print.
Make sure the printer you want to use is selected. Select the appropriate envelope size in the Paper Size pop-up menu (if available).
select the Orientation option. NOTE: If you do not see these options, click the disclosure triangle next to the Printer pop-up menu or click Show Details. 7.
Select any other print settings that you want, and then click Print to begin printing. Print on envelopes 33 Chapter 2 Print photos Do not leave unused photo
paper in the input tray.
The paper might start to curl, which could impair the quality of your printout. Photo paper should be flat before printing. Follow the instructions for your
operating system.  • Print photos on photo paper (Windows) Print photos on photo paper (Mac OS X) TIP: This printer includes HP ePrint, a free service
from HP that allows you to print documents on your HP ePrint-enabled printer anytime, from any location, without any additional software or printer drivers.
For more information, see HP ePrint. Load paper in the tray. For more information, see Load media. On the File menu in your software application, click
Print. Make sure the printer you want to use is selected. To change settings, click the option that opens the printer Properties dialog box.
Depending on your software application, this option might be called Properties, Options, Printer Setup, Printer, or Preferences. On the Paper/Quality tab,
select the appropriate photo paper type from the Media drop-down menu. Click Advanced, and then select Best or Maximum DPI from the Output Quality
drop-down menu. To print the photo in black and white, click the Grayscale drop-down menu, and then select the following option: High-Quality Grayscale:
uses all the available colors to print your photo in grayscale. Load paper in the tray. For more information, see Load media. From the File menu in your
software application, click Page Setup. NOTE: If you do not see a Page Setup menu item, go to step 3. b. Make sure the printer you want to use is selected in
the Format For pop-up menu.
c. Select the paper size from the Paper Size pop-up menu, and then click OK. 3. From the File menu in your software application, click Print. 4.
Make sure the printer you want to use is selected. 5. Select the appropriate paper size from the Paper Size pop-up menu (if available). 34 Print 6. Click Paper
Type/Quality from the pop-up menu, and then select the following settings: • Paper Type: The appropriate photo paper type • Quality: Best or Maximum dpi
NOTE: If you do not see these options, click the disclosure triangle next to the Printer pop-up menu or click Show Details.
7. If necessary, change the photo and color options: a. Click the disclosure triangle beside Color Options and select the appropriate Photo Fix options: • Off:
Applies no automatic adjustments to the image. To print the photo in black and white, click Grayscale from the Color pop-up menu, and then select the
following option: High Quality: Uses all the available colors to print your photo in grayscale. Select any other print settings that you want, and then click
Print to begin printing. Print borderless documents or photos Borderless printing lets you print to the edges of certain photo media types and a range of
standard media sizes. NOTE: Before printing a borderless document, open the file in a software application and assign the image size. Make sure the size
corresponds to the media size on which you are printing the image. nOTE: Not all applications support borderless printing. Follow the instructions for your
operating system.
Load paper in the tray. For more information, see Load media. On the File menu in your software application, click Print. Make sure the printer you want to
use is selected. To change settings, click the button that opens the Properties dialog box. Depending on your software application, this button might be called
Properties, Options, Printer Setup, Printer, or Preferences. Click the Paper/Quality tab, and then click the Advanced button. In the Borderless Printing
option, click Print Borderless, and then click the OK button. In the Media drop-down list, select the appropriate paper type. Load paper in the tray.
For more information, see Load media. From the File menu in your software application, click Page Setup. NOTE: If you do not see a Page Setup menu item,
go to step 3. b. Make sure the printer you want to use is selected in the Format For pop-up menu.
c. Select an available borderless paper size from the Paper Size pop-up menu, and then click OK. From the File menu in your software application, click
Print. Make sure the printer you want to use is selected. Select the paper size from the Paper Size pop-up menu (if available).
Click Paper Type/Quality from the pop-up menu, and then select the following settings: • Paper Type: The appropriate paper type • Quality: Best or
Maximum dpi NOTE: If you do not see these options, click the disclosure triangle next to the Printer pop-up menu or click Show Details. 7. Make sure the
Print Borderless check box is selected. 8. If necessary, click the disclosure triangle beside Color Options and select the appropriate Photo Fix options: • Off:
Applies no automatic adjustments to the image. Select any other print settings that you want, and then click Print to begin printing. 36 Print 3 Scan You can
use the printer’s control panel to scan documents, photos, and other originals and send them to a variety of destinations, such as a folder on a computer. You
can also scan these originals from your computer using either the HP software provided with the printer or TWAIN-compliant or WIA-compliant programs.
When scanning documents, you can use the HP software to scan documents into a format that you can search, copy, paste, and edit.
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NOTE: The HP scanning software does not support TWAIN and WIA scanning on computers running Mac OS X.
NOTE: Some scan functions are only available after you install the HP software. If you have problems scanning documents, see Solve scan problems. This
section contains the following topics: • • • Scan an original Scan using Webscan (HP Officejet 4620 e-All-in-One series) Scanning documents as editable text
Scan an original This section contains the following topics: NOTE: Your printer and computer must be connected and turned on. NOTE: If you are scanning
an original from the printer control panel or from your computer using the HP printer software, the HP software provided with the printer must be installed
on your computer prior to scanning. In addition, on Windows computers, the HP software must be running prior to scanning. NOTE: If you are scanning a
borderless original, load the original on the scanner glass, not the ADF. • Scan to a computer Scan to a computer To scan an original to a computer from the
printer control panel 1. Load your original print-side down in the right-front corner of the glass or in the ADF. For more information, see Load an original
on the scanner glass or Load an original in the automatic document feeder (ADF). 2.
Press the button to the right of Scan, and then select the computer to which you want to scan. Press the button to the right of Start Scan. scan 37 Chapter 3 To
scan an original from HP printer software 1. Load your original print-side down in the right-front corner of the glass or in the ADF. For more information,
see Load an original on the scanner glass or Load an original in the automatic document feeder (ADF).
2. On the computer, open the HP scanning software: • Windows: From the computer desktop, click Start, select Programs or All Programs, select the folder
for your HP printer, and then select HP Scan. • Mac OS X: Double-click the HP Scan 3 icon. This icon is located in the Hewlett-Packard folder that is in the
Applications folder at the top level of the hard disk. Make changes to the scan settings, if needed.
NOTE: Use the HP software to scan documents into editable text, a format that allows you to search, copy, paste, and edit within the scanned document. Use
this format to edit letters, newspaper clippings, and many other documents. For more information, see Scanning documents as editable text. Scan using
Webscan (HP Officejet 4620 e-All-in-One series) Webscan is a feature of the embedded web server that lets you scan photos and documents from your printer
to your computer using a web browser. This feature is available even if you did not install the printer software on your computer. NOTE: If you are unable to
open Webscan in the EWS, your network administrator might have turned it off. For more information, contact your network administrator or the person who
set up your network. For more information, see Embedded web server (HP Officejet 4620 e-All-in-One series). to scan using Webscan 1. Load your original
print-side down in the right-front corner of the glass or in the ADF.
For more information, see Load an original on the scanner glass or Load an original in the automatic document feeder (ADF). For more information, see
Embedded web server (HP Officejet 4620 e-All-in-One series). 3. Click the Scan tab, click Webscan in the left pane, change any settings, and then click Start
Scan. TIP: To scan documents as editable text, you must install the HP software included with the printer. For more information, see Scanning documents as
editable text. 38 Scan Scanning documents as editable text When scanning documents, you can use the HP software to scan documents into a format that you
can search, copy, paste, and edit. This allows you to edit letters, newspaper clippings, and many other documents. This section contains the following topics: •
• To scan documents as editable text Guidelines for scanning documents as editable text To scan documents as editable text Use the following guidelines for
scanning documents as editable text. Follow the instructions for your operating system.
windows 1. Load your original print-side down in the right-front corner of the glass or in the ADF. For more information, see Load an original on the
scanner glass or Load an original in the automatic document feeder (ADF). 2. From the computer desktop, click Start, select Programs or All Programs,
select the folder for your HP printer, and then select HP Scan.
3. Select the type of editable text you want to use in the scan: I want to. Extract just the text, without any of the formatting of the original Extract the text, as
well as some of the formatting of the original Follow these steps Select the Save as Editable Text (OCR) shortcut from the list, and then select Text (. txt) from
the File Type drop-down menu. Select the Save as Editable Text (OCR) shortcut from the list, and then select Rich Text (.
rtf) from the File Type drop-down menu. Or Select the Save as PDF shortcut from the list, and then select Searchable PDF (. To start the scan, click Scan, and
then follow the onscreen instructions. mac OS X 1. Load your original print-side down in the right-front corner of the glass or in the ADF. For more
information, see Load an original on the scanner glass or Load an original in the automatic document feeder (ADF). This icon is located in the HewlettPackard folder in the Applications folder at the top level of the hard disk. Select the Documents preset from the Presets pop-up menu. After the scan is
complete, click the Save button in the HP Scan toolbar 7. Select the type of editable text you want to use in the scan: I want to.
Extract just the text, without any of the formatting of the original Extract the text, as well as some of the formatting of the original Follow these steps Select
TXT from the Format pop-up menu. Guidelines for scanning documents as editable text To ensure that the software can convert your documents successfully,
do the following: • Make sure the scanner glass or ADF window is clean. When the printer scans the document, smudges or dust on the scanner glass or ADF
window can be scanned, as well, and can prevent the software from converting the document to editable text. For more information about cleaning the
scanner glass or ADF, see Clean the scanner glass and lid backing or Clean the ADF. Make sure the document is loaded correctly. When scanning documents
as editable text from the ADF, the original must be loaded into the ADF with the top forward and face up. When scanning from the scanner glass, the original
must be loaded with the top facing the right edge of the scanner glass. Also, make sure the document is not skewed. For more information, see Load an
original on the scanner glass or Load an original in the automatic document feeder (ADF). Make sure the text on the document is clear.
To successfully convert the document to editable text, the original must be clear and of high quality. The following conditions can cause the software to not
convert the document successfully: ◦ The text on the original is faint or wrinkled.

You're reading an excerpt. Click here to read official HP
OFFICEJET-4622 user guide
http://yourpdfguides.com/dref/5506702

◦ The text is too small.  The structure of the document is too complex. ◦ The text is tightly spaced.
For example, if the text that the software converts has missing or combined characters, "rn" might appear as "m. " ◦ The text is on a colored background.
Colored backgrounds can cause images in the foreground to blend too much. • • 40 Scan • • Choose the correct profile. Be sure to select a shortcut or preset
that allows scanning as editable text.
These options use scan settings designed to maximize the quality of your OCR scan. Save your file in the correct format. If you want to extract just the text
from the document, without any of the formatting of the original, select a plain text format (such as Text (. txt) or TXT). If you want to extract the text, as well
as some of the formatting of the original, select Rich Text Format (such as Rich Text (. Scanning documents as editable text 41 4 Copy You can produce highquality color and grayscale copies on a variety of paper types and sizes. NOTE: If you are copying a document when a fax arrives, the fax is stored in the
printer's memory until the copying finishes. As a result, the number of fax pages that can be stored in memory might be reduced. This section contains the
following topics: • • Copy documents Change copy settings Copy documents You can make quality copies from the printer control panel. to copy documents 1.
Make sure you have paper loaded in the main tray. For more information, see Load media. 2. Place your original face down on the scanner glass or face up
in the ADF. For more information, see Load an original on the scanner glass or Load an original in the automatic document feeder (ADF). NOTE: If you are
copying a photo, place the photo on the scanner glass face down, as shown on the icon on the edge of the scanner glass. 3. From the Home screen on the
printer control panel, press the button to the right of Copy. For more information, see Change copy settings. 5.
To start the copy job, press the button to the right of Black Copy or Color Copy. NOTE: If you have a color original, selecting Black Copy produces a
blackand-white copy of the color original, while selecting Color Copy produces a fullcolor copy of the color original. Change copy settings You can
customize copy jobs using the various settings available from the printer's control panel, including the following: • • • • • • 42 Copy Number of copies Copy
paper size Copy paper type Copy speed or quality Lighter/Darker settings Resizing originals to fit on different paper sizes You can use these settings for
single copy jobs, or you can save settings to be used as defaults for future jobs. To change copy settings for a single job 1. From the Home screen on the
printer control panel, press the button to the right of Copy.
2. Press the (Setup) button, and then, using the buttons on the right, scroll to and select the copy function settings you want to change. 3. Press the (Back)
button, and then press the button to the right of Black Copy or Color Copy. To save the current settings as defaults for future jobs 1.
From the Home screen on the printer control panel, press the button to the right of Copy. 2. Press the (Setup) button, and then, using the buttons on the right,
scroll to and select the copy function settings you want to change. 3. Using the buttons on the right, scroll to and select Set As New Defaults, and then press
the button beside Yes. Change copy settings 43 5 Fax You can use the printer to send and receive faxes, including color faxes. You can schedule faxes to be
sent at a later time and set up speed-dials to send faxes quickly and easily to frequently used numbers. From the printer control panel, you can also set a
number of fax options, such as resolution and the contrast between lightness and darkness on the faxes you send. NOTE: Before you begin faxing, make sure
you have set up the printer correctly for faxing. You might have already done this as part of the initial setup, by using either the control panel or the HP
software provided with the printer.
You can verify the fax is set up correctly by running the fax setup test from the control panel. For more information on the fax test, see Test fax setup. This
section contains the following topics: • • • • • • • • • Send a fax Receive a fax Set up speed-dial entries Change fax settings Fax and digital phone services Fax
over Internet Protocol Clear the fax log View the Call History Use reports Send a fax You can send a fax in a variety of ways. Using the printer control panel,
you can send a black-and-white or color fax. You can also send a fax manually from an attached phone. This allows you to speak with the recipient before
sending the fax. This section contains the following topics: • • • Send a fax using the printer control panel Send a fax from the computer Send a fax manually
from a phone Send a fax using the printer control panel This section contains the following topics: • • • • • Send a fax Send a fax using monitor dialing Send a
fax from memory Schedule a fax to send later Send a fax to multiple recipients 44 Fax Send a fax You can easily send a single- or multiple-page black-andwhite or color fax by using the printer control panel. NOTE: If you need printed confirmation that your faxes were successfully sent, enable fax confirmation
before sending any faxes. For more information, see Print fax confirmation reports. TIP: You can also send a fax manually from a phone or by using monitor
dialing.
These features allow you to control the pace of your dialing. They are also useful when you want to use a calling card to charge the call and you have to
respond to tone prompts while dialing. to send a fax from the printer control panel 1. Load your original print-side down in the right-front corner of the glass
or in the ADF. For more information, see Load an original on the scanner glass or Load an original in the automatic document feeder (ADF).
2. From the Home screen, press the button to the right of Fax. 3. Enter the fax number by using the keypad. TIP: To add a pause in the fax number you are
entering, press * repeatedly, until a dash (-) appears on the display.
4. Press the button to the right of Start Fax, and then press the button to the right of Black or Color. TIP: If the recipient reports issues with the quality of the
fax you sent, you can try changing the resolution or contrast of your fax. Send a fax using monitor dialing Monitor dialing allows you to hear dial tones,
telephone prompts, or other sounds through the speakers on the printer. This enables you to respond to prompts while dialing, as well as control the pace of
your dialing. TIP: If you are using a calling card and do not enter your PIN fast enough, the printer might start sending fax tones too soon and cause your
PIN not to be recognized by the calling card service.

You're reading an excerpt. Click here to read official HP
OFFICEJET-4622 user guide
http://yourpdfguides.com/dref/5506702

If this is the case, you can create a speed dial entry to store the PIN for your calling card. For more information, see Set up speed-dial entries. NOTE: Make
sure the volume is turned on to hear a dial tone. Send a fax 45 Chapter 5 To send a fax using monitor dialing from the printer control panel 1.
load your originals. For additional information, see Load an original on the scanner glass or Load an original in the automatic document feeder (ADF). 2.
From the Home screen, using the buttons on the right, select Fax, select Start Fax, and then select Black or Color.  If the printer detects an original loaded
in the ADF, you hear a dial tone.  If you load your original on the scanner glass, select Fax from Glass. 3. When you hear the dial tone, enter the number by
using the keypad on the printer control panel. 4. Follow any prompts that might occur.
TIP: If you are using a calling card to send a fax and you have your calling card PIN stored as a speed dial, when prompted to enter your PIN, press the
button to the right of Quick Contacts to select the speed dial entry where you have your PIN stored. Your fax is sent when the receiving fax machine answers.
Send a fax from memory You can scan a black-and-white fax into memory and then send the fax from memory. This feature is useful if the fax number you are
trying to reach is busy or temporarily unavailable. The printer scans the originals into memory and sends them once it is able to connect to the receiving fax
machine.
After the printer scans the pages into memory, you can immediately remove the originals from the document feeder tray or scanner glass. NOTE: You can
only send a black-and-white fax from memory. For additional information, see Load an original on the scanner glass or Load an original in the automatic
document feeder (ADF). 2. From the Home screen on the printer control panel, press the button to the right of Fax.
3. Press the (Setup) button, and then, using the buttons on the right, scroll to and select Scan and Fax. Enter the fax number by using the keypad, or press the
button to the right of Quick Contacts to select a number from the phone book or a previously dialed or received number. 6. Press the button to the right of
Start Fax Black. The printer scans the originals into memory and sends the fax when the receiving fax machine is available. Schedule a fax to send later You
can schedule a black-and-white fax to be sent within the next 24 hours. This enables you to send a black-and-white fax late in the evening, when phone lines
are 46 Fax not as busy or phone rates are lower, for example. The printer automatically sends your fax at the specified time. You can only schedule one fax to
be sent at a time.
You can continue to send faxes normally, however, while a fax is scheduled. nOTE: You can only send scheduled faxes in black-and-white. NOTE: You need to
set date and time for the printer before you can use this feature. For additional information, see Load an original on the scanner glass or Load an original in
the automatic document feeder (ADF). 2. From the Home screen, press the button to the right of Fax. 3. Press the (Setup) button, and then, using the buttons
on the right, scroll to and select Send Fax Later. 4. Enter the send time by pressing the buttons to the right of the arrow keys, and then press then button to the
right of OK.
5. Enter the fax number by using the keypad, or press the button to the right of Quick Contacts to select a number from the phone book or a previously dialed
or received number. 6. Press the button to the right of Start Fax Black. The printer scans all pages and the scheduled time appears on the display.
The fax is sent at the scheduled time. to cancel a scheduled fax 1. Press the Send Fax Later message on the display.  OR – From the Home screen on the
printer control panel, press the button to the right of (Setup) button, and then, using the buttons on the right, scroll to Fax. Send a fax 47 Chapter 5 Send a fax
to multiple recipients You can send a fax to multiple recipients at once by grouping individual speed dial entries into group speed dial entries.
For more information, see Set up speed-dial entries. For additional information, see Load an original on the scanner glass or Load an original in the
automatic document feeder (ADF). 2. From the Home screen on the printer control panel, press the button to the right of Fax, press the button to the right of
Quick Contacts, scroll to and select Phone Book, and then select the recipient group. 3. Press the button to the right of Start Fax, and then press the button to
the right of Black. The printer sends the document to each number in the group speed dial entry. NOTE: You can only use group speed dial entries to send
faxes in black and white, because of memory limitations. The printer scans the fax into memory then dials the first number. When a connection is made, it
sends the fax and dials the next number.
If a number is busy or not answering, the printer follows the settings for Busy Redial and No Answer Redial. If a connection cannot be made, the next number
is dialed and an error report is generated. Send a fax from the computer You can send a document on your computer as a fax, without printing a copy and
faxing it from the printer. NOTE: Faxes sent from your computer by this method use the printer’s fax connection, not your Internet connection or computer
modem. Therefore, make sure the printer is connected to a working telephone line and that the fax function is set up and functioning correctly. To use this
feature, you must install the printer software using the installation program provided on the HP software CD provided with the printer. windows 1. Open the
document on your computer that you want to fax. 2. On the File menu in your software application, click Print.
3. From the Name list, select the printer that has “fax” in the name. 4. To change settings (such as selecting to send the document as a black fax or a color
fax), click the button that opens the Properties dialog box. Depending on your software application, this button might be called Properties, Options, Printer
Setup, Printer, or Preferences.
5. After you have changed any settings, click OK. Enter the fax number and other information for the recipient, change any further settings for the fax, and
then click Send Fax. The printer begins dialing the fax number and faxing the document. 48 Fax Mac OS X 1.
Open the document on your computer that you want to fax. 2. From the File menu in your software application, click Print. 3. Select the printer that has
“(Fax)” in the name. 4. Select Fax Recipients from the pop-up menu below the Orientation setting. NOTE: If you cannot find the pop-up menu, click the
disclosure triangle next to the Printer selection or click Show Details. 5. Enter the fax number and other information in the boxes provided, and then click Add
to Recipients.
6. Select the Fax Mode and any other fax options you want, and then click Send Fax Now to begin dialing the fax number and faxing the document.
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Send a fax manually from a phone Sending a fax manually allows you to make a phone call and talk with the recipient before you send the fax. This is useful
if you want to inform the recipient that you are going to send them a fax before sending it. Depending on how the recipient has their fax machine set up, the
recipient might answer the phone, or the fax machine might take the call. If a person answers the phone, you can speak with the recipient before sending the
fax. If a fax machine answers the call, you can send the fax directly to the fax machine when you hear the fax tones from the receiving fax machine. To send a
fax manually from an extension phone 1. Load your original print-side down in the right-front corner of the glass or in the ADF. For more information, see
Load an original on the scanner glass or Load an original in the automatic document feeder (ADF).
2. From the Home screen on the printer control panel, press the button to the right of Fax. 3. Dial the number by using the keypad on the phone that is
connected to the printer. NOTE: Do not use the keypad on the control panel of the printer when manually sending a fax.
You must use the keypad on your phone to dial the recipient's number. 4. If the recipient answers the telephone, you can engage in a conversation before
sending your fax. NOTE: If a fax machine answers the call, you will hear fax tones from the receiving fax machine. Proceed to the next step to send the fax.
5. When you are ready to send the fax, press the button to the right of OK, and then press the button to the right of Black or Color. If you were speaking with
the recipient before sending the fax, inform the recipient that they should press Start on their fax machine after they hear fax tones. The telephone line is silent
while the fax is transmitting. At this point, you can hang up the telephone. If you want to continue speaking with the recipient, remain on the line until the fax
transmission is complete. send a fax 49 Chapter 5 Receive a fax You can receive faxes automatically or manually. If you turn off the Auto Answer option, you
must receive faxes manually. If you turn on the Auto Answer option (the default setting), the printer automatically answers incoming calls and receives faxes
after the number of rings that are specified by the Rings to Answer setting. (The default Rings to Answer setting is five rings.
) For more information, see Change fax settings. If you receive a Legal-size or larger fax and the printer is not currently set to use Legalsize paper, the
printer reduces the fax so that it fits on the paper that is loaded. If you have disabled the Automatic Reduction feature, the printer prints the fax on two pages.
NOTE: If you are copying a document when a fax arrives, the fax is stored in the printer memory until the copying finishes. As a result, the number of fax
pages that can be stored in memory might be reduced.  • • • • • • • • Receive a fax manually Set up backup fax Reprint received faxes from memory Poll to
receive a fax Forward faxes to another number Set the paper size for received faxes Set automatic reduction for incoming faxes Block unwanted fax numbers
Receive faxes to your computer using HP Digital Fax (Fax to PC and Fax to Mac) Receive a fax manually When you are on the phone, the person you are
speaking with can send you a fax while you are still connected. this is referred to as manual faxing. Use the instructions in this section to receive a manual
fax. You can receive faxes manually from a phone that is: • • Directly connected to the printer (on the 2-EXT port) On the same phone line, but not directly
connected to the printer To receive a fax manually 1. Make sure the printer is turned on and you have paper loaded in the main tray.
2. Remove any originals from the document feeder tray. 3. Set the Rings to Answer setting to a high number to allow you to answer the incoming call before
the printer answers. Or, turn off the Auto Answer setting so that the printer does not automatically answer incoming calls.
50 Fax 4. If you are currently on the phone with the sender, instruct the sender to press Start on their fax machine. 5. When you hear fax tones from a sending
fax machine, do the following: a. From the Home screen on the printer control panel, press the button to the right of Fax, press the button to the right of OK,
and then press the button to the right of Receive Fax Manually.
b. After the printer begins to receive the fax, you can hang up the phone or remain on the line. The phone line is silent during fax transmission. Set up backup
fax Depending on your preference and security requirements, you can set up the printer to store the faxes it receives. NOTE: If backup fax is enabled and you
turn the printer off, all faxes stored in memory are deleted, including any unprinted faxes that you might have received while the printer was in an error
condition. You must contact the senders to ask them to resend any unprinted faxes. For a list of the faxes you have received, print the Fax Log. The Fax Log is
not deleted when the printer is turned off. to set backup fax from the printer control panel 1. From the Home screen, press the (Setup) button.
2. Using the buttons on the right, scroll to and select Fax Setup, select Advanced Setup, and then select Backup Fax Reception. 3. Scroll to and select the
required setting, and then press the button to the right of OK. on The default setting. When Backup fax is On, the printer stores all received faxes in memory.
This enables you to reprint up to 30 of the most recently printed faxes if they are still saved in memory. NOTE: When printer memory is low, it overwrites the
oldest, printed faxes as it receives new faxes. If the memory becomes full of unprinted faxes, the printer stops answering incoming fax calls. NOTE: If you
receive a fax that is too large, such as a very detailed color photo, it might not be stored in memory due to memory limitations.
On Error Only Causes the printer to store faxes in memory only if an error condition exists that prevents the printer from printing the faxes (for example, if
the printer runs out of paper). The printer continues to store incoming faxes as long as there is memory available. (If the memory becomes full, the printer
stops answering incoming fax calls. ) When the error condition is resolved, the faxes stored in memory print automatically, and then they are deleted from
memory. faxes are never stored in memory.
For example, you might want to turn off Backup fax for security purposes. If an error condition occurs that prevents the printer from printing (for example,
the printer runs out of paper), the printer stops answering incoming fax calls. Off Receive a fax 51 Chapter 5 Reprint received faxes from memory When
Backup Fax Reception mode is set to On, the received faxes are stored in memory, whether the printer has an error condition or not. NOTE: After the memory
becomes full, the oldest, printed faxes are overwritten as new faxes are received.
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